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Technology 
your Servant?

… or Servant to
Technology?
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Technology Distraction
Attention Deficit Trait

Why Smart People
Underperform

15 minutes
per interruption

2007 Microsoft Study
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Internal
Interruptions

21

74
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564
Switch Tasks

Combating Technology Induced 
Attention Deficit Trait

1. Workplace & 
Personal Health

2. Attention 
Management Skills

3. Time Task Email 
Management 
Methodology

1. Workplace & 
Personal Health
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2. Attention 
Management 

Skills

Write Down the Most Chaotic 
Environment for You to Work
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Turn Off Outlook Notifications?

Turn Off Notifications - Outlook
File > Options > Mail
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On Busy Days, Do Not Check 
Email until 10 am?
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Limited Do Not Disturb
No Communication Devices

NOT All Day!!!

Easy Task Capturing to Record 
Random Neural Firings to 

Clear your Head!

Are you Enabling or
Empowering?



9

Have a Problem? … Better
Have a Solution with it!!

Micro-Managing is Bad
… and it invites interruptions

After you plant a seed in the 
ground, you don’t dig it up every 

week to see how it is doing!
- William Coyne, former 3M Sr. VP for R&D

Office-Drama is a 
Time Suck!
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70% of communication is 
body language & tone ... 

Never kick a fresh turd 
on a hot day.

- Harry S. Truman

I didn’t steal 
his book.
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I didn’t steal 
his book.

I didn’t steal
his book.

I didn’t steal 
his book.
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I didn’t steal 
his book.

We Talk Faster 
Anyway!

Type = 40-50 words/min
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Text = 20 words/min

Speak = 150 words/min

3. Time Task Email 
Management Methodology
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Help!  My Inbox is Exploding!

Email & Task
Game Plan
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File E-Mail Bankruptcy

Archive Anything Older than 30 Days … or Keep 
Latest 300-500 and Process the Rest

Email Projects

Don’t Be Myopic
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Reduce Incoming Email

Permission to NOT say

“Thanks”
with email

What is your RTS ratio
with email? (respond to sender)

Are you Resolving email

or inviting more?
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Send invitation(s) to a date …

NOT “Are you available on 
August 23rd?”

Microsoft FindTime

Microsoft Dictate
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Use Autotext for 
Repeat Responses

Page 23

Use Templates for Repeat 
Responses

PC
Mac
iOS
Android

Share Email Rights to 
Trusted Assistant?
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One Size Fits All?

Batch Process
Email

Plot your Batch Process Times

Today’s Batch Email Processing

7:30 AM 15 minutes

10:00 AM 30 minutes

12 Noon 90 minutes

4:00 pm 30 minutes

5:00 pm 15 minutes

… or plot it out on your calendar
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3 Minute
Rule

Touch it Once

THE 4 
D’s
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Delete
Do
Delegate
Delay

THE 4 D’s

Email Rules -
Delegated Items

Page 28

Delayed Email
& Task

Management
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Delay – Temporarily -
Leave in Inbox

Delay - Longer than 24 
Hours – Take out of Inbox

Record the Task/To Do
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Create Task from Email

Create Task from Email

Remember Outlook 
Quick Steps!
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Docket the Deadline on 
Calendar/PM Software

Schedule on Calendar
(deadline + time to do it)

File the Email
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Foundation for Email 
Management = DMS
(all integrate with Outlook)

Task 
Management

“I don’t mind change, 
so long as it doesn’t disturb 

what I currently do.”
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Electronic/Program 
Based Task Lists

Si
ri

Wunderlist
(owned by Microsoft)
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Microsoft ToDo

Tasks Come from Many Sources

Master
Task List
Master
Task List

Meetings

Random
Neural
Firings

People

Phone

Paper & 
Mail Email

Sticky
Notes &

Lists

Goals & 
Bucket 

List
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11th Hour Mode

Microsoft ToDo

Task List Categories

• Client Work – General

• Administrative

• Business Development

• Personal/Home
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Good Descriptions in your 
Task List

Work on Smithville Project

Good Descriptions in your 
Task List

Smithville Project – Review Jones report for 
security issues and draft recommendations 
by October 15th.

www.myaquanotes.com
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Exercise: Collection

Master
Task List
Master
Task List

Meetings

Random
Neural
Firings

People

Phone

Paper & 
Mail Email

Sticky
Notes &

Lists

Goals & 
Bucket 

List

“STUFF”

Email/Meeting Item/Etc.

What is it?

Is it Actionable NO

YES

Trash

Someday/
Maybe

File/Reference

What’s the 
Next Action

Matters
(planning)

Will it take less than 2 mins.?

YES NO
DO IT! Delegate it Defer it

Waiting
(for someone else) Task/Calendar File/Reference

Matters
(review for 

actions)

* or can you do it in the amount of time 
that you have allocated to batch process 
your “stuff”

Managing the Master Task List
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Short List 
v

Long List
v

Calendar

Daily Tasks

Out of Sight … Out of Mind
… So Paper is OK!

… Paper, the Killer App!
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Morning Review 
Reminders, Calendar 

& Task List

Write your Daily Task List
(Prioritization!  3-5 items)

Tuesday Tasks

1. Enter yesterday’s time that I forgot
2. Review prebills
3. VA  project (2 hours)
4. Call Sam
5. Research Jones statute of limitations

… or plot it out on your calendar!

… or plot it out on your calendar!
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Following a plan is good for progress, but 
opportunity usually exists off the plan.

Simon Sinek

… be disciplined, but not too rigid! … 

Morning Planning
Self-Journal, Focus, etc.

Do “Huddles” in the AM with 
Team Members
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Create Your Morning Ritual

6:30 Wake Up/Meditate
6:45 Sunscreen on Bald Head!
7:00 Oatmeal/Tea/Fish Oil
8:00 Sales/Prof Development
9:00 Project Management
10:00 Email & Task - Revisit
11:00 Start Client Work
noon Run & Workout
5:00 Plan Tomorrow/Tasks
5:30 Enter Missing Time 

Checklist Again!
(iTunes/iPad App Store)

Create AM/PM Rituals
iPad/iPhone App



35

Once-a-Week
Deep Review 

(performed weekly)

Weekly
Review

Calendar 
2 weeks 
Forward

Calendar 
2 weeks 

Back

**Time 
Entry 

Report

Task List + 
Delegated 

Items
Process 
Email

Loose 
Papers, 
Notes

Matter or 
Project 

List (DMS 
or PM)

Should take
1 Hour

Weekly
Review

Calendar 
2 weeks 
Forward

Calendar 
2 weeks 

Back

Matter or 
Project 

List (DMS 
or PM)

Task List + 
Delegated 

Items
Process 
Email

Loose 
Papers, 
Notes

Time 
Entry 

Report

Should take
1-2 Hours
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Time Entry Practices

Lawyers who reconstruct their time 
weekly tend to lose 25 to 30 percent of 
their time (up to 50% if reconstructed at 
end of the month).

Time Entry Practices

50 Timekeepers losing ½ hour a day 
results in a loss of $500,000 annually.

Your Action Plan?
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Attack Emails in 
Batches

Delete
Do
Delegate
Delay

Convert Emails to 
Tasks … then File!

Maintain Master Task 
List (probably Outlook)
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SmartPhone Captures 
Tasks (Random Neural Firings)

Work from 
Daily Task List

Print your Daily 
Short List!

Disciplined Weekly 
Reviews

Use the Buddy System
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Pomodoro Single 
Tasking!

Remember your 
Reset Button!!
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THANK YOU!

(877) 676‐5492

punger@affinityconsulting.com

Paul Unger

@PaulJUnger, 

Like ACG!

https://www.linkedin.com/in/paul‐unger‐1126974
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Tame the Digital Chaos  
 

Distraction, Time, Task and Email Management 
 

 
 

I. INTRODUCTION  

 

 

 

The purpose of this seminar is simple … teach you the habits you need to make technology 
your servant and gain control of your work day and personal life. 

Technology is supposed to be our servant.  However, for most of us, we have become a 
servant to technology.  We need to turn that scenario around, and make technology work 
for us … not against us.  Technology is controlling us in a very negative way.  Technology 
is supposed to be helping us do more in less time.  You’ve heard it … Do more in less time 
and go home early, right?!  If that is the case, then what happened?  In my humble opinion, 
we have all become so dazzled by technology that we lost common sense.  I hear comments 
all the time like: 

“I can’t get anything done because I get so many emails every day!” 

“My work piles up because of all my interruptions.” 

“I do better with good old-fashioned paper.” 

“I can’t keep track of my tasks … I constantly let things slip between the cracks.” 

I am fairly sure that managing tasks and time is a problem that has probably been around 
for a very long time.  Most of us wish that we had another few hours a day to get things 
done.  For most of us, technology has hurt us almost as much as it has helped us.  Add up 

I welcome change, as long as 
nothing is altered or different! 
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the number of emails, instant messages, smartphones, social media posts, laptop 
computers, tablets, and we just cannot escape the endless number of interruptions that 
prevent us from focusing and “being present” to tackle all that we must do in a single day.   

The system outlined below combines distraction management skills with some of the time 
management techniques outlined by experts like David Allen, Dr. Stephen Covey, etc., but 
applies them utilizing technology tools for professionals in a much more simplified way.  
Many time management experts shy away from technology, if not outright reject it!  I 
firmly believe this is a huge mistake.  Reverting back to paper in this day and age is a cop-
out, especially in the age of technology and smartphones.   
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II. DISTRACTION MANAGEMENT 

A. Information Overload – Managing Distractions in the 21st Century: 150 emails, 
… 50 instant messages, … 20 telephone calls, … 15 walk-in interruptions, … 25 
social media notifications, … 50 email or internet curiosity breaks, … that totals 
310 digital interruptions.  Divide that into 480 workday minutes and that is an 
interruption every 1.55 minutes!  Most studies that I see indicate that the average 
American worker is interrupted every 2-3 minutes.  Now let’s look specifically at 
just internal interruptions … In 2015, the average American worker checks 
Facebook 21 times per day, takes 74 email curiosity breaks, and switches tasks on 
a computer 564 times a day!  With these numbers of external and internal 
interruptions, it is incredible that we get any deep level project work accomplished. 

In a 2007 Microsoft Corp. study, researchers concluded that it takes 15 minutes to 
return back to the work that computer programmers were performing at the time of 
an electronic-based interruption.  If we get interrupted every 2-3 minutes, and it 
takes 15 minutes to return back to the work we were performing, how do we get 
anything done during the course of the day?  This is why we look at our timesheets 
somedays at 5 pm and see only 2 hours of billable time, but we feel like we put in 
a 14-hour day. 

 The reality is that we live in an age of information overload.  We are constantly 
connected to the world and inundated with information.  We sleep with our 
smartphones … we are surrounded by 24-hour news networks … social media … 
tablet computers … we can't escape.  This is why very smart people underperform.  
Do you ever wonder why your head is in a constant cloud and you are unable to 
focus?  It is called Attention Deficit Trait (ADT) and it is becoming a world-wide 
epidemic.   

ADT is a relative to Attention Deficit Disorder (ADD), but it is very different in 
that ADD has a genetic component.  ADT does not.  ADT is environmentally 
induced, and in today's age of information overload, those environmental factors 
are technology-based.  In other words, ADT is a condition that is in large part 
caused by the technology and connectivity that we love so much.  Yes, the very 
technology that we love so much is causing us to walk around with foggy brains 
and causing us to underperform.  The scary part is that no one knows the long term 
effects of information overload.  However, some shorter term studies suggest that 
the problem is getting worse.  More recent studies show that it takes slightly over 
23 minutes to return back to the work we were performing at the time of a digital 
interruption. 

What can we do about it?  We need to rethink and realign the way that we live with 
technology.  Listen, I love technology.  It is my life and passion, but I sometimes 
don't like it so much, especially when it has a negative impact on productivity and 
my personal life.  We combat ADT and overcome our inability to focus by attacking 
ADT on four fronts: 
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1. Personal Health 

2. Workplace Health 

3. Learning a Time, Task & Email Methodology 

4. Learning Attention & Distraction Management Skills  

Personal Health is important on two fronts – Physical and Mental.  Physically, we 
know that when we are fit, well-rested and healthy, we feel like we can conquer 
anything.  When we overeat, and when we are sleep-deprived, every situation 
sometimes seems to be doomed for failure.  As an example, we know that we cannot 
eat a foot-long sub full of meat and processed bread, a bag of chips and piece of pie 
for lunch and come back and expect to stay awake or concentrate.  From a mental 
health perspective, we also know how difficult it is to concentrate and be productive 
when we are depressed, or when we are focusing on a personal relationship that is 
suffering.  We can't ignore these two important areas of our personal life.  If these 
areas need improvement, hire a personal trainer and start exercising, and go see a 
therapist or life coach to help get your physical and mental health back on track. 

Workplace or Organizational Health is also very important.  We know how difficult 
it is sometimes to focus in an environment that is negative or unhealthy.  We know 
how difficult it is to operate in an environment full of drama and distrust.  We need 
to focus on ways to improve workplace health.  I am not a subject matter expert on 
this, but a great starting point that I recommend would be two books – Five 
Dysfunctions of a Team and The Advantage, both by Patrick Lencioni.   

Learning a Time, Task and Email Management Methodology is the third front that 
we need to address.  We need an effective way to (1) process the hundreds of digital 
and human interruptions/tasks that we receive during the course of a day, and (2) 
organize the tasks, digital information, and paper information that hits our desk.  In 
other words, we need a digital methodology to get organized … and stay organized.  
If we don't have system in place, we will operate in state of chaos.  Studies show 
that if we do not have an effective task management system to capture our tasks 
and file away that information, we continue to worry about those things, which has 
an enormous impact on our ability to focus.  I am an advocate of using and 
customizing tools like Microsoft Outlook and our smartphones to process this 
information.  For those of you in the legal profession, I also think that legal 
document management systems can be extremely helpful to legal professionals.  
These are tools like Worldox, NetDocuments, iManage or OpenText.   

Attention Management Skills is the fourth front that we need to address.  As it 
relates to this, I want to share 5 Attention Management tips that are easy, practical, 
and will make an immediate impact on your ability to focus: 

1. Turn Off ALL Notifications.  Notifications are bad.  Why would we give the 
world a hotline to our brain?  Turn all notifications off … and I mean ALL of them.  
In Outlook, email notifications can be turned off by navigating to File > Options > 



 Page 5 

Mail and deselecting the four different methods of notifying you when a new 
message arrives.   

 
 

On an iPhone, go to Settings > Notifications and go through and turn off 
notifications by App. 

2.  Practice Single Tasking.  It is not enough to say that multi-tasking is bad.  We 
need to practice single-tasking.  We need to clear our desks AND our multiple 
monitors of information that is not directly relevant to the project that we are 
executing.  For example, you should always minimize Outlook on your second 
monitor unless you are batch processing emails, planning your upcoming tasks, or 
using that information for the task that you are performing.  Why would you leave 
up on your beautiful 21" screen the single most chaotic distraction known to man 
in the 21st century … Email.  That is insane if you think about it.  Email feeds us 
distraction bombs every 30 seconds to 5 minutes.  How can we possibly focus if 
we see those bombs land in our inbox?  Just because we have 2 or 3 monitors, 
doesn't mean that we need to have something displayed on them, especially if the 
information displayed derails our ability to focus on the task in front of us! 
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3.  Pomodoro.  Pomodoro is an easy technique that utilizes the 25-minute tomato 
timer.  We single-task (preferably deep-thought work) for 25 minutes and then take 
a break and do something relaxing for 5 minutes.  In other words, we work in 
intervals.  The human brain functions very well, maintaining attention to a single 
task for 25 minutes.  After 25 minutes, we begin to lose focus.  By giving ourselves 
a 5 minute break, we can return to deep-thought work for another 25 minutes very 
easily.  Feel free to adjust the 25 minutes to something a bit longer if you want.  I 
know a lot of folks who work 40 minutes or longer and take a 5-10 minute break.  
This technique will make a huge impact on productivity and will also help combat 
procrastination.  Think about it, we can endure even the most tedious dreaded task 
for 25 minutes, right?  Once we get a little momentum going and we get immersed 
in the project, it becomes a lot easier.  One important note:  Do not process emails 
during your 5 minute break!  Take a real break and do something relaxing like 
getting some fresh air or water, or take a 2-3 minute walk.   

4.  Tackle Deep-Thought Work Early in the Day (or when rested).  Dive into 
deep-thought work, writing, projects early morning.  There is little question about 
it … our brains function better following quiet time or sleep.  We also know that 
we can be highly productive while the rest of the world is sleeping because there 
are far fewer (if any) interruptions.  This can be one of the most productive times 
of the day. 

5.  Create Rituals.  Rituals are small checklists or short rigid schedules designed 
to execute the same desired tasks during a set period of time.  Rituals keep you on 
task.  They are extremely helpful because they help us form positive habits and 
prevent us from taking email or internet curiosity breaks.  As an example, I have a 
morning administrative ritual whenever I am physically in the office and not 
speaking.  It looks something like this: 

 Eat breakfast at my desk (Oatmeal)  

 Fish oil, garlic & vitamins 

 Reach out to one new organization for business development (speaking) 

 Ask a potential client or existing client to grab coffee in a city where I am 
speaking 

 Review my potential new client report 

 Reach out to past clients without active matters just to check in 

 Check in on recent clients/projects 

 Business social media 

 Birthday wishes 
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 Check in with my leadership team members 

 Check in with my partners 

 Check in with my immediate team 

Rituals also remind us to do things that we frequently forget … things that we 
commit ourselves to do as New Year resolutions or annual goals.  By adding rituals 
and checklists into your life, you can greatly enhance your ability to focus and do 
those things that seem to always fall off our radar.  I discovered an awesome App 
for the iPhone/iPad called Checklist Again to organize all my daily rituals. 

B. Pardon the Interruption: In an eight (8) hour work day, if we receive 100 emails, 
that equates to receiving one email every 4.8 minutes.  Sound familiar?   It should, 
because that is the world most of us live in.  Combine that with instant messages, 
phone calls and what I call email curiosity interruptions, that equates to one 
interruption every 2-3 minutes!  What can you do to minimize the distraction? 

Take the following quick survey: 

1. Interruption Survey: 

• Average number of emails you get per day: ................................  

• Average number of instant messages per day: .............................  

• Average number of phone calls you get each day: ......................  

• Average number of curiosity email or internet breaks each day:   

• Total  Interruptions Per Day ....................................................  

2. Other Questions to Ask Yourself: 

• What percentage of interruptions really need  
immediate attention? ....................................................................  

• Has technology simplified your life?  Yes  No 

• Is technology controlling you?  Yes  No 

C. Are You Using Outlook Effectively?  Probably not. Although millions of people 
use Outlook, most do not use all of its functionality to their advantage.  In this 
seminar, we'll give you some great tips for making better use of Outlook. 

D. How Do You Track Tasks?  At least 75% of those people polled in technology 
audits that I perform indicate they keep track of tasks on a piece of paper or a legal 
pad, and then end up transferring and combining those notes. 
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E. Email Storage & Archival: What do we do with all the email we get and prevent 
it from being such a major interruption to your productivity?  There are several 
problems related to this: 

• How should you archive old email? 

• How do you deal with attachments and keep from losing them? 

• How do you search for old conversations quickly and efficiently? 

• How do you keep your email but not run out of server space?  Why does the IT 
person keep telling you that you have too much email in your inbox and you're 
clogging up the server? 

• How do we stop using our inbox as a task list? 

F. Too Much Legitimate Email To Deal With Effectively: Many people simply 
receive more email than they can read and keep up with.  How do you sort, store 
and track all of this email?  What can we do to reduce the amount of email that we 
receive? 

G. Spam Getting Through: There are lots of ways to avoid SPAM, and yet it still 
manages to get into our mailboxes.  What can you do about it? 

In the forthcoming chapters, we will address the strategies and practical solutions 
to these problems. 
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III. TASK & TIME MANAGEMENT 
 

 

 

 

Task management is the process of capturing/recording tasks and executing them in an 
efficient manner.   

Time management is how you utilize your time to execute the tasks on your plate.  
Although quite related to task management, they are quite different.   

At one end of the extreme, there are people who know exactly the 250 items on their task 
list, but sometimes can’t accomplish one of those tasks on a given day because he/she 
cannot focus and execute.  These folks tend to be over-thinkers.  They cannot execute 
because they get so tripped up on thinking through every scenario to the point of mental 
exhaustion.     

At the other end of the spectrum, there are those who are excellent at executing tasks that 
they do, but other tasks slip between the cracks because maybe they are terrible 
capturers/recorders. 

Most of us are poor at both because we simply have too much to do in a given day.  The 
reality is that urgency is a fact of life.  I have visited thousands of legal professionals over 
my career, and I have yet to encounter a law office that doesn’t operate in that environment!  
Now, layer in technology, and most of us are even worse because we have let technology 
dazzle us to the point that we have lost most of our common sense.  I am talking primarily 
about email, but it extends to social media, internet use, and apps on our mobile devices.  
In the middle we have those of us who simply do not get to items 100-225 because we 
simply do not have enough time.   

While technology can be blinding us of the solution, the beautiful thing about technology 
is that it can solve the capturing/recording, and at the same time make us more efficient to 
do more in less time.  I am also an advocate of using SOME paper (limited) in our 
workflow.  Sometimes it just isn’t smart to use a computer monitor when paper would 
better serve us, … or we simply don’t have enough computer monitors to display all the 
information that we need. 

A. Starting Point – Gathering Everything: The starting point to effective time 
management is carving out the time you don’t have ;-) to gather all your tasks, goals 
and “random neural firings”.  This includes everything from the post-it notes on 
your desk and in your car, to loose papers, to new lists and old lists of unresolved 
items and issues.  At this point, do not worry about whether you should gather it or 
not … just do it and err on the side of gathering it. 

Are you going to embrace technology so 
you can master it, or are you going to 
remain a servant to technology? 
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B. Record Everything – the Master Task List:  Many time management experts 
develop elaborate and separate task lists.  In my belief, these techniques fail because 
they are too complicated and there are too many lists in too many places.  For task 
management to work, it must be simple and convenient.  It cannot take you 6 
months to learn and master the system!  Maintain just as many lists as you need, 
but not too many.  Think about using the following four categories/lists: 

1. Client – General 

2. Administrative 

3. Business Development 

4. Home/Personal 

Start entering everything into the Master Task List.  For this, I strongly recommend 
Outlook or Wundelist (www.wunderlist.com), integrated with Outlook.   

C. Why Outlook + Smartphone is the Ultimate Capture Tool:  Remember my rule.  
This process must be convenient and simple.  Outlook is consistent with my rule 
because of its convenience, ease, versatility and ability to integrate with 
smartphones.  If you cannot easily “capture and record” your random neural firing, 
thought or task quickly and in a central location, that task will either be lost or 
quickly forgotten.  Outlook via Smartphones offer this solution.  Before 
smartphones, maintaining a task list in Outlook was nearly impossible because you 
simply can’t carry your desktop computer around and you cannot wait 5 minutes 
for a laptop to boot up and start Outlook in order for you to capture and record the 
task.  Smartphones (and tablets like the iPad) are instantly available.  You can use 
Siri on an iPhone or voice commands on an Android device to create the reminder 
or task.  There is no boot-up process.  In fact, arguably, it is faster than recording it 
on a random piece of paper.  It is certainly better to record in on the smartphone 
because it can be instantly “organized” and even more importantly, instantly backed 
up, thus far less likely to be lost like a post-it note or a napkin. 

  

http://www.wunderlist.com/
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In Outlook, enter the task as such: 

 

1. Enter the Subject starting with the name of the matter, followed by a description 
of the action item.  By using the matter name at the beginning, you can group all 
tasks for that matter together when you sort the subject alphabetically, as seen 
here: 

 

2. (Optional) Enter a Start Date so that you can optionally view your master list 
with the ability to exclude items that you do not need to worry about/view yet.  
This is sometimes helpful for those people with task lists of 100 or more items. 

3. (Optional, but Recommended) Enter a Due Date so that you can optionally view 
tasks with due dates and view those tasks in different colors.  Also note the 
Reminder option below that, if you so desire. 

4. Set a Priority (High, Normal, Low).  Not everything is High, despite your feeling 
of being overwhelmed.  Should you believe everything is urgent, then pretend you 
are categorizing the level of urgency.  So your day will consist of the following: 

a. High = Urgent + Deadlines 
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b. Normal = Less Urgent 

c. Low = Less Urgent 

d. Someday Items = These are items that are more akin to new year 
resolutions or goals.  Add “Someday” to the beginning of the Subject line 
so they can be grouped together when sorted: 

 

5. Enter any Notes in this area that you may find helpful or if you do not have enough 
room in the Subject line. 

D. Capture Tasks from E-Mail through Drag and Drop:  Many sources of tasks 
are from received emails.  You can simply drag email onto your calendar or tasks 
button in Outlook and it will make an appointment or task out of it (but it leaves 
your original email where it was so then you can file it away – covered later). 

 
 

To include attachments from the email into the Task, simply right-click and drag 
the email to the Task module: 
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E. Daily Task List:  Once you complete your master task list, you are ready to start 
developing a daily task list from the master task list.  Ideally, select 3-5 items.  If 
you accomplish those, pick another 3.  A daily task list can be accomplished many 
ways.  Here are some of the ways.  Review the master task list each morning when 
planning the day, and: 

1. Use a paper index card and write down 3-5 items; or 

2. Flag items to do today; or 

3. Use category/color to designate items to work on today; or 

4. Print and simply highlight those items to work on today; or 

5. Identify those tasks to work on today and make appointments for yourself to 
complete the desired work. 

F. Make Appointments for Some Tasks and Larger Project Work:  Many time 
management experts recommend this technique.  I do like this, but it can be abused 
and can set you up for failure if you start ignoring the appointments or cannot get 
to them because the schedule is unrealistic.  Be sure to also add the task to your 
task list.  Also think about making appointments to handle emails that you have 
been skipping over. 

G. Views – Outlook Tasks:  As discussed above, if you name your tasks based on the 
matter or project first, and then a hyphen followed by a description of the work, 
you can sort your task list and see all the work that needs done on a particular 
project.  Then modify your task list to show only active tasks (not completed).  To 
do this,  

In Outlook, from the File ribbon, select Change View, Active and the Save 
Current View As a New View. 
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Then select View Settings and Sort.  Select Sort by Subject. 
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H. Flags: If you process you inbox down to zero every day and the volume of email 
that you receive is lower, flags can be a good tool for you.  Flags can alert you to 
follow up on an important task or email. Simply right-click on the desired email 
and select Follow Up and then select the desired follow-up flag.  Additionally, by 
Flagging as email, the email will automatically show up on your Task List.  I use 
flags sparingly in email, and typically just for items that will stay in my inbox for 
a couple days.  Otherwise, I fear that this technique may encourage people to use 
the inbox and its subfolders as a task list (which is something that I adamantly 
oppose and I discuss later). 

 
You can set a custom date as well.  Outlook will notify alert you on the date and 
time specified. 

 
 

I. Outlook Categories for Tasks: (Optional) This is a feature that can help you group 
tasks together based on subjects (like Client, Administrative, Business 
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Development, Home/Personal), if you don’t use separate lists.  Right-click the 
category column next to the task item that you would like to categorize. 

 

 

Next, select the desired color.  Customize Categories and name them major 
areas of work so you can sort and view based on those categories. 
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If you decide to use Categories, I recommend that you customize your view to not 
only sort based on the subject (see above), but also group the list by the categories 
that you create.  To do this, select View Settings > Group By Categories and Sort  
by Subject (ascending): 
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When finished, save your view: 
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IV. THE EMAIL PROBLEM  

The typical professional today sends and receives about 110 messages daily.1  Without 
question, email is one of the most important technological communication advancements 
of the past 100 years.  It has fundamentally changed the way we communicate with clients 
and the way that we do business.  We run our businesses today via email communication 
instead of face-to-face communication.    

For some professionals, emails present a wide array of issues that most of the business 
world and ordinary consumers will never face.  In this seminar, we will discuss these issues 
and teach you how best to deal with them.  These issues or problems range from ethical 
considerations to email overload and time-management.  While there is no perfect solution, 
there are many methods to effectively handle email.   

The first step to any problem is to understand the problems that exist.  We must get our 
arms around all the email issues that we face.  The second step is to isolate each problem 
and tackle each problem, without forgetting how that might affect other email problems.  
For instance, controlling spam email may prevent you from getting an important email 
from a client if your spam filter inadvertently catches an email from a client.   In other 
words, when you solve one problem, it may open up a different can or worms. 

V. DEALING WITH THE OVERLOAD - YOUR EMAIL GAME PLAN 

A. Batch Process Emails:  Most professionals need to be more deliberate about when 
they check emails instead of checking email 70+ times a day or leaving their 
Outlook inbox maximized all day long.  We need to reduce the number of 
interruptions (email or otherwise) so we can be more focused.  After all, how on 
earth can anyone get anything done with an interruption every 2-3 minutes?   

Ask yourself the following question:  10 years ago, would you have let someone 
walk in your office every 2-3 minutes offering to sell you a product… or asking 
you for a favor? 

Of course you wouldn't!  So, why do you let it happen now with your email?  Why 
do you drop everything that you are doing to read and/or respond to that email that 
just arrived?!  You have invested thousands of dollars in this wonderful technology 
that is supposed to make you more efficient, but instead it has created an 
interruption hotline going straight to your brain. 

Some time management experts suggest checking email 2 times a day.  While this 
may sound like a good plan, it is unrealistic for most people.  When email was just 
becoming popular, there wasn't an expectation that it would be dealt with 
immediately, so 2 times per day was probably okay.  However, in today's age that 
has changed to some degree.  Entire companies communicate via email.  Email is  

                                                 
1 In 2010, a study by the Radicati Group found that business users send and receive 110 emails each day. 
http://www.radicati.com/wp/wp-content/uploads/2010/04/Email-Statistics-Report-2010-2014-Executive-
Summary2.pdf  

http://www.radicati.com/wp/wp-content/uploads/2010/04/Email-Statistics-Report-2010-2014-Executive-Summary2.pdf
http://www.radicati.com/wp/wp-content/uploads/2010/04/Email-Statistics-Report-2010-2014-Executive-Summary2.pdf
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a way of life and the way everyone communicates.  Checking email twice a day 
isn't enough.  I think regularly through the day is more realistic and just as 
important, will make it easier for you to prevent your inbox from growing out of 
control. 

One way to handle this is deal with email at the same time every day.  Many 
professionals simply cannot do this, as they live, breath and communicate via email 
instead of face-to-face or phone meetings.  If you can handle emails at more 
deliberate times, you could get more project work completed and follow a plan.  
Here is an example: 

1 – Upon arrival at the office:  8:00 am 

2 – Mid morning:  10:30 am 

3 – After lunch:  12:30 pm 

4 – Afternoon:  3:30 pm 

5 – End of day:  5:00 pm 

B. Treat Email Inbox like your U.S. Mail Box – Keep it Empty!  Would you ever 
keep your U.S. Mailbox in this condition with 1000+ items?  Of course you 
wouldn't.  So don’t let your inbox get that way!  However, for most people, 
maintaining email is the weakest link in their system of organization primarily 
because of volume and frequency.  They use it as a holding bucket for undecided 
and unresolved tasks. 

The key to mastering your inbox is to keep it empty – or under 20.  For most people, 
in order to process email efficiently, you must be able to see your emails in a single 
screen (or close to it).  It is very difficult and overwhelming to process emails and 
tasks when you are staring at a screen with 500 emails. 

So what do you do with your U.S. Mailbox?  One of the best time 
management/organization tips that I learned and implemented nearly ten years ago 
is this:  Throw away your (U.S.) junk mail and advertisements before you get into 
the house.  Only bring mail into your house that you intend to do something with! 

C. 3 Minute Rule – DELETE, DO, DELEGATE, DELAY  

When processing or attacking your email, do one of four things with that email:  
DELETE, DO, DELEGATE, DELAY.  The 3-minute rule is gold!  Any email that 
can be responded to or dealt with (saved in a client file, forwarded, deleted, etc.) 
within 3 minutes should be dealt with immediately – the first time you lay eyes on 
it.  This rule is based on the premise that the 2nd time you have to deal with the 
email, it will take you longer than 3 minutes navigate to it, open it, read it, 
comprehend it, re-familiarize yourself with the topic and then handle it.  So, why 
not just respond to it if you have the 3 minutes to deal with it! 
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D. Delete  - Whatever You Can Immediately! Learn how to use the DELETE key.  
That could be the first thing that you do before you start dealing with email … just 
like not bringing junk mail and annoying advertising into your home.  Delete the 
following: 

• All the email that gets past your SPAM filter. 

• Interoffice SPAM that is irrelevant to you. 

• CCs that you don’t need to save, etc. 

• Jokes from annoying friends and coworkers. 

• Email from people you don't like (unless it's important, of course) 

Outlook Tip – Delete Large Chunks of Email: Sort email based on the 
From field (by hitting the From column header).  You can often get rid of 
tons of email sent from the same person.  Remember that you can select a 
chunk of email by single left-clicking on the first email – holding the Shift-
key down and single left click on the last email. Then hit Delete. 

Outlook Tip – Delete Emails Permanently: By holding the Shift key 
down and hitting Delete, the email will be deleted from both your Inbox 
and Deleted Items folder in one step.  You will be asked to confirm if this 
is indeed what you want to do: 

 

E. Do – Just Do It! 

If you can answer the question … make the decision … provide the solution … 
bring it to a resolution, then just do it!  Don't forget that you may be able to deal 
with it more quickly by picking up the phone or walking around the corner. 
Remember, an email often times invites another email. 

Finally, if it is an email that is going to take a while, you should dispose of it in 
under 3 minutes by adding it to your task list (or calendar) and then saving it into 
the appropriate client/matter file. 

F. Delegate - If Appropriate: If someone else should be handling the task or issue in 
the email, then hand it off appropriately.  Don't let someone else put “the monkey” 
back on you, in the words of The One Minute Manager Meets the Monkey by 
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Kenneth Blanchard.  You can make this easy to track by setting up the Delegated 
Email rule described below or use a Quickstep. 

G. Delay - If Necessary: Already mentioned in the 3-minute rule above, if it is an 
email that is going to take a while, you should simply dispose of it in under 3 
minutes by adding it to your task list and then saving it into the appropriate 
client/matter file. 

• Do not use your Outlook Inbox as your to-do list by leaving unresolved email 
in your inbox. 

• If you keep a paper-based task list, simply write it in and save the email in 
appropriate place. 

• If you use Outlook to manage your task list, simply drag it over to your Task 
button in the Outlook navigator. 

• In some circumstances, it is okay to set up subfolders under your inbox.  Clean 
them out on a weekly basis. 

• If you schedule your tasks as appointments, add it to you calendar. 

H. Outlook Views Which Will Help: 

1. To See More Email In One Screen: 

a. Turn Off Viewing Pane: This occupies a lot of screen space that 
could otherwise be displaying email.  To turn it off, click the View 
menu  Reading Pane  Off. 

b. Turn Off Date Grouping: By default, Outlook groups your email 
by date received.  The date categories just occupy space and prevent 
you from seeing all of your email on one screen.  To turn it off, click 
the View menu  Arrange By  uncheck Show in Groups. 

c. Turn Off Viewing Pane: This occupies a lot of screen space that 
could otherwise be displaying email.  To turn it off, click the View 
menu  Reading Pane  Off. 

AutoText for Frequent Email Repeat Responses 

We all have responses that we constantly have to retype or we spend 10 minutes 
looking for a similar email that we drafted recently to another person.  We automate 
the creation of documents, so why wouldn’t we automate the emails that we 
frequently draft.  Instead of wasting this time, create an AutoText entry in Outlook 
to automate the response! 
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• Find the "model text" that you want to use as the AutoText entry.  Copy it into 
your Windows clipboard (select and hit CTRL-C). 

• Draft a new email and paste it into the body of the new email.  Format it and 
clean it up.  I suggest removing any client names … make it generic. 

• Select the text and then select Insert > Quick Parts > AutoText > Save Selection 
to AutoText to AutoText Gallery. 

 

• Give it a name (nickname) with at least 4 characters. 

• To use the AutoText entry, simply place your cursor in the body of the email 
(in the desired location), and then type the first 4 characters of the AutoText 
name.  You will see a pop-up preview of your entry.  If you want to insert it, 
simply hit your Enter key.  Another way to insert it is to select Insert > Quick 
Parts > AutoText > and then select the AutoText entry from the preview 
gallery. 

VI. LEARNING THE NUTS & BOLTS OF OUTLOOK EMAIL 

A. Main Storage Problems: 

1. Disorganization: Most people have hundreds or thousands of unrelated 
messages in their inboxes.  This is equivalent to taking all of the paper out 
of your files and throwing it on the floor of the file room.  The point is, if 
it's not organized, then it's mostly useless. 

2. Storage Space Limitations: You may have been scolded by your IT folks 
about this.  If you're using Microsoft Exchange on your server, then it can 
get overloaded with the quantity of emails and attachments you keep in your 
inbox and Outlook folder structures.  If you don't have Exchange, then all 
of those emails (and contacts, and appointments and tasks) are stored in a 
PST file on your hard drive or the server.  The bigger that database, the 
slower your computer will run.  Of course, the database can also over-run 
your storage capacity. 

3. No One Else Can See Your Email But You: In most cases, if you have an 
important client communication in Outlook, no one else in your office can 
see it.  In many cases, we want to share this information, but don't know 
how to do it. 
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4. Difficulties Searching: Many people complain that it's nearly impossible 
to efficiently search old emails for a particular conversation.  What can you 
do to make this task easier? 

B. Start by Organizing the Inbox: Setting up folders and using Rules is a great way 
to start to organize your Outlook. 

1. How To Set Up a New Email Folder: To Setup a new Subfolder in your 
Inbox, right-click the Inbox (or your mailbox)  New Folder.  Give it a 
name and make sure it will contain Mail and Post Items.  Then click OK. 

 
2. Outlook Rules: Rules allow you to auto-process incoming email (among 

other things).  Here's how you set one up: 

• Click the Tools menuRules and Alerts. 

• Click the New Rule button. 
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• Follow the steps for selecting the Condition, Action, Exceptions, then 

give it a name and make sure the rule is turned on! 

3. Sample Rule - Delay Sent Mail By One Minute (in case you change your 
mind) 

• In Outlook, click on the Tools menu  Rules and Alerts  New Rule 
button. 

• Under "Start from a blank rule," choose "check messages after sending." 

• On the next screen ("which conditions do you want to check"), don't 
check anything (you want this rule to apply to every email you send) 
and click the Next button at the bottom.  You'll see the following dialog 
(click Yes): 
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• In the next screen, check "defer delivery by a number of minutes," and 
then click the hyperlink for "a number of" at the bottom of the screen 
and enter the number of minutes you want to delay your email. 

 
• Click Next and add any exceptions (for people you don't want to delay 

email to). 

• Click Next, name your rule Delay and click Finish. 

 

  



 Page 27 

4. Sample Rule - Keep Track of Delegated Items and Email: Many people 
forward email to others to deal with but have a difficult time remembering 
what they delegated for follow up purposes.  Here's a rule that will help. 

• First, create a folder in Outlook called  
"!Delegated Items".  Use an exclamation mark at the beginning of the 
name if you want so it floats to the top of your Inbox subfolder list: 
 

 

• In Outlook, click on the File menu  Manage Rules and Alerts  New 
Rule button. 

• Choose "Apply rule on messages I receive" (that translates to "Apply 
this rule after the message arrives") and click Next at the bottom of the 
dialog. 

• Under "Select Conditions", check BOTH "from people or public group" 
and "where my name is in the CC box."  At the bottom of the dialog, 
click the hyperlink for "people or public group" and add your email 
address.  We're basically creating a rule that will look for emails from 
you and copied to yourself.  Click Next. 

• Under "Select Actions … What do you want to do with the message," 
choose "move it to the specified folder" (and if you want, “Flag for 
Follow-up”. Flag for follow-up will automatically add the email to your 
Task List).  Make the specified folder your Inbox for Delegated Items 
folder, if you haven't already. Click Next and add any exceptions 
(probably none).  Click Next, name it (something like “Delegated 
Items”) and click Finish. 

Your final Rule should look something like this: 
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C. Conditional Formatting to Apply Color to Emails. 
 
Sometimes you may like to automatically apply color to important email. This is 
not done with a rule.  Instead, you use conditional formatting.   

 

Here is how: 

1. In Outlook Email, go to the View ribbon.  Select View Settings.  Next, 
select Conditional Formatting. 

  

2. Select Add and give it a name.  I called mine below “Tom Bolt” because I 
want all emails from Tom Bolt to turn BLUE in 8 pt Showcard Gothic 
Font.  Next, select the Font button to select the desired font, color & 
size.  Finally, select the Condition button. 



 Page 29 

 

 

3. Set the condition.  I selected a specific sender. You can set your own 
condition, such as all emails where the subject line contains “ABA”. 
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D. Outlook Add-On Programs To Help You Sort and Store Your Email: There 
are many third-party programs that integrate with Outlook which can help you 
organize, sort and store your email (both incoming and outgoing).  The major 
downside to these programs are that the email gets saved in your Outlook Mailbox, 
which is a huge problem because (1) no one else can have access to those emails 
(big problem in law firms, and (2) you are encouraging the saving of emails in 
Mailboxes that are probably already nearing or over Outlook’s capacity).  With that 
huge, caveat, below are a few to options: 

1. SpeedFiler by Claritude: See www.claritude.com.  This program will auto 
file incoming and outgoing messages and has sophisticated search 
functions.  It has a 30 day free trial, and it's $25/$40 to buy. 

2. SimplyFile by TechHit: See www.techhit.com/simplyfile.  This program 
will auto file incoming and outgoing messages.  It has a 30 day free trial, 
and it's $40 to buy.  TechHit also sells a program called EZDetach which 
helps you manage attachments to email and it will work in conjunction with 
SimplyFile. 

3. Xobni:  See www.xobni.com; find people, email & attachments instantly; 
it's FREE. 

4. Sanebox:  See www.sanebox.com; Sanebox service that automatically sorts 
your email into several folders based on each email's importance, which is 
often determined by the sender. For example, it can automatically route 
email newsletters that you want and subscribe to, into a Read Later folder 
without have to set up an Outlook Rule.  It learns your preferences based on 
your behavior. 

 

E. Archiving Old Outlook Email: Many Outlook users end up with an enormous 
accumulation of email in their Sent Mail and Deleted Mail folders.  Furthermore, 
some mail is sorted into subfolders and forgotten about.  All of this will start to bog 
down servers and PCs as those databases of emails get larger and larger.  
Thankfully, Outlook has an excellent way to dealing with this problem - 
AutoArchive.  In a nutshell, AutoArchive will allow you to a) permanently delete 
expired items; b) delete or c) archive old items to an archive file (archived 
database).  Conveniently, the first time AutoArchive runs, it creates the archive 
database for you.  It is stored on the C:\ by default so you'll either want to move it 
to a server folder or back it up directly from your C:\.  Once it has established itself, 
you'll see the Archive folder in your Outlook Folder List.  There are two sets of 
AutoArchive settings: global settings and per-folder settings. 

1. Turn AutoArchive On or Off. Click the Tools menu  Options  Other 
tab  click the AutoArchive button.  At the top of the following dialog, 
you'll see "Run AutoArchive every __ days."  If you uncheck that box, it 
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will not run.  As you can see from the following screen shot, you have many 
options for this: 

 
Note that these are your default (global) AutoArchive settings. 

2. Control the Archive Settings of a Specific Folder: You can control what 
any particular folder does in Outlook by following these steps:  Right-click 
the folder  choose Properties  click the AutoArchive tab  Make your 
changes and click OK. 

F. Saving Email Messages Outside of Outlook: When an email message is in your 
Outlook inbox, it's just a record in a database and not a discreet document like a 
Word file.  That fact is a big part of the problem associated with organizing and 
storing them.  Email related to a particular matter is stored in one place; and word 
processor files related to that matter are stored somewhere else.  However, you can 
create documents out of those emails and those documents can be stored with every 
other document related to a particular matter or issue. 

1. Saving Email as You Would Save a Document: The classic problem that 
organizations have if they do not own a document management system is 
saving and finding matter or project-specific email.  Why?  Because people 
(1) keep them in their individual inboxes, or (2) save them in subfolders 
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within their own inbox (which no one else has access to), or (3) delete the 
email altogether.  Email is valuable correspondence that in most 
circumstances should be saved in a central location where everyone in the 
office can have access to it.    

As it turns out, you can save email much like you save a Microsoft Word 
document clicking the File menu  Save As.   I recommend that you save 
emails as a Outlook Message Format (*.msg) format.   

   

2. Saving Email By Dragging Into a Windows Explorer Folder: You can 
clean out your inbox or subfolders under your inbox by cascading the 
windows and simply dragging and dropping all of them into the desired 
folder.  This will COPY the emails over into that folder, saving them 
automatically as MSG (native Outlook Message Format) files, which 
preserves the metadata and all attachments. 

 
3. Saving Email With Document Management Programs (DMS): While 

document management programs (Worldox, Interwoven Worksite, 
NetDocuments, etc.) were originally thought of as only word processing 
document repositories, that is no longer true.  They can now store just about 
any type of computer file (word processor, PDF, TIF, email, JPG, etc.).   

4. Worldox Example: Using Worldox as an example, it provides 3 different 
ways to save emails (see below).  Once profiled and saved, the emails are 
stored within the client/matter structure and easily searchable and accessible 
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by anyone who uses the document management system (Worldox, in this 
case)..  It's also important to note that you can save them one-at-a-time or 
large quantities of them all at once. 

a. Save Email From Within Outlook - Drag and Drop: Saving to 
Worldox from within Outlook – Drag and Drop on the Worldox 
"folder" for a particular matter. 

 
b. Save Email From Within Worldox - Copy or Move Buttons: The 

Worldox/Outlook integration also provides Copy To Worldox or 
Move to Worldox buttons (located in the toolbar region of 
Outlook).  Simply select the email(s) you want to save into the 
system, then click the appropriate button shown below. 
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c. Save Email From Within Worldox: Saving email from the 
Worldox Email Tab which allows you to see your Outlook inbox 
from within Worldox. 

 
 

5. Saving Email as PDF Files: If you have Adobe Acrobat, it installs a few 
plug-ins in Microsoft Outlook.  For those that wish they had a good way to 
archive and store emails and attachments, this integration can be appealing.  
The downside of this method is that the email is no longer a native Outlook 
message, and it loses some of its valuable metadata.  You can’t open it and 
reply or forward it from Outlook.  It is now a PDF.  That isn’t the end of the 
world by any means, but it is a potential downside. 

 

 

a. Acrobat - Creating PDFs from Individual Emails or Entire 
Folders: Simply select individual emails (Ctrl + left click) or select 
entire folders; then click Convert Selected Messages or Convert 
Selected Folders. This will create a single PDF which contains all of 
the emails you’ve selected and all of the attachments thereto.   

b. Acrobat - Adding Subsequent Emails to Existing PDFs: If you 
receive additional emails which need to be added to an existing PDF 
archive, simply choose Append to Existing Adobe PDF. 
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c. Acrobat - Automatic Archival: As you can see from the screen 
shot, you can also setup folders to automatically archive themselves.  
This would be particularly useful if you have setup Outlook rules to 
automatically sort your email into specific folders and then use 
Acrobat to automatically archive it. 

 

d. Saving PDFs without Acrobat: If you don't have Acrobat, you can 
still save email as PDFs.  You're not going to get the slick Outlook 
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integration buttons and menus, but you can certainly open an email 
and create a PDF from it using any PDF creator program, several of 
which are free.  For example, I would recommend either of the 
following free PDF makers. 

• PDF995 - free - www.pdf995.com 

• PDFCreator - free - http://sourceforge.net/projects/pdfcreator 

G. Email Storage Tips: 

1. Store Email with Other Related Files: Store the email in the same location 
as other electronic files related to any particular matter.  Any system that 
requires you to save email separately from other electronic files related to a 
matter is inadequate. 

2. Delete or Archive Email Once Stored: After an email is stored into a 
folder or a document management system, delete or archive it.  Keep 
Outlook as clean as possible. 

3. Always Separately Save Attached Documents: Outlook is NOT a 
document management system and should not be used as a document 
repository.  Documents attached to Outlook emails are actually stored in a 
temporary folder structure that is incredibly convoluted and is normally 
hidden.   

4. Stop Printing Email: If you've saved email digitally, then they're easily 
searchable and printing them to throw in paper files only makes your paper 
files fatter, harder to manage and harder to search. 

H. Benefits of Storing Email Outside of Outlook: 

1. No Worry About Email Storage Limitations: If you save email as 
separate files or in other programs, then you can free up mailbox space in 
Outlook and Exchange Server.  As such, the IT folks will stop complaining 
that you're overloading the Exchange Server and your computer will operate 
faster. 

2. Everyone Else Can Find Them Too: Once saved as separate files, others 
in your office will be able to find these important client communications.  
You're on your way to building a complete digital file. 

3. Searchable Like All Other Documents: If you’re saving into a document 
management system, then the content of all email stored therein is 
searchable.  If the email is stored as separate files (PDFs, MSG files), then 
there are free or very inexpensive search programs that can help you find 
any of them by the words contained inside them. 
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VII. OTHER OUTLOOK TIPS AND TRICKS 

A. Create Contacts from Email: Drag and drop an email to the Contacts button and 
Outlook will create a new contact card for that email sender. 

B. Right-Click Email for All Possible Options: Also known as alternate clicking, 
this feature will present very handy functions such as Open, Reply, Print, Forward, 
etc. 

 
 

C. Out of Office Assistant: If you're going to be out of the office, this is a way to 
automatically notify people who send you email.  To turn on this feature, click File 
> Automatic Replies. 
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D. Saving Attachments to Email: 

1. One At A Time: Open the email, right click the attachment and choose 
Save As. 

2. In Bulk: 

• Outlook 2010/2013 – File button  Save Attachments 

 

E. Set up your Signature Block:   

In Outlook, click the File menu  Options button  Mail tab (left side)  
Signatures button. 
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F. Distribution Lists in Outlook:  

If you routinely send email to a group of people, you can create a distribution list 
or contact group which will make it much easier.  For example, I have a Contact 
Group called Affinity which automatically sends the email to 5 other people.  All I 
have to type in the TO box is Affinity.  Go to your Contacts in Outlook  New 
Contact Group button (Home ribbon)  name the group and add the appropriate 
email addresses. 

 

G. Find Contacts Super Fast:  

For the Quick Contact Search, just hit the F11 key and type in a first or last name. 

H. Edit The Auto-Complete List:  
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If you send an email to a person one time, then Outlook will remember their email 
address the next time you start typing anything that begins with the first letters of 
that person's email address.  This has resulted in lots of email being sent to the 
wrong person.  Outlook auto-completes an email address and it's the wrong one.  In 
Outlook 2007, if you want to get rid of that person from auto complete you only 
sent one email to, start typing a name in the TO box of a new email.  When the list 
appears, use your arrow keys to highlight the one you want to delete, then hit your 
delete key.   

 
They've made this process easier in Outlook 2010 and 2013.  Just start typing a 
name and when the auto-complete list of names appears, you can hover over the 
one you want to remove with your mouse and click the X that appears on the right 
side of each name: 

 
 

I. Mailbox Cleanup:  

From the File menu  Info tab (left side)  Cleanup Tools button.   
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See below for all of the options it provides: 
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J. Advanced Search Capability:  

This feature gives you a tremendous number of options for searching through 
Outlook.  Simply hit Ctrl + Shift + F. 

 
K. Email Quick Search:   

At the top of each mail folder, you'll see a box like the one below: 

 
This will search for words you type in the email address or body of any email 
contained in that folder and it's very fast. 

L. Junk Mail Settings:  

Click on Mail  Junk button in the Delete group of the Home ribbon  Junk Email 
Options. 
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M. Block Senders:   

The easiest way to do this is to right-click an email from a sender you want to block 
in the future.  Choose Junk  Block Sender.   

  



 Page 44 

VIII. GENERAL EMAIL TIPS AND NETIQUETTE:  

A. Spelling and Grammar: Use proper spelling and grammar.  Emails that have 
proper spelling and grammar are more professional and easier to read.  It will also 
reduce the risk of misunderstanding, which is quite common with email 
communication. 

B. Always Include Contact Info: Always include your contact information in your 
signature, even your replies.  It just saves everyone time. 

C. When in a Hurry, be Extra Careful: While we are on the road, it is really easy 
for us to skim an email and miss something that is very important.  Sometimes it is 
better to wait to reply until you have a moment to read the email carefully.  Failure 
to do so can end of costing a lot of people, including yourself, a lot of time, money 
and drama. 

D. Don’t Be Rude: Remember there is a human being on the other end of the email.   
It is easy to forget in this age of electronic communication.  It is pretty easy to be 
rude when you aren't looking at them in the face. 

E. Never Send an Angry Email: Never send an email if you are angry or frustrated.  
Wait 10 minutes, an hour, or even overnight if necessary.  Better yet, many times 
it might be better to pick up the phone and have a live conversation. 

F. Use a Subject Line: Clearly describe the message contents in the Subject line.  A 
clear and concise description helps everyone organize their Inbox. 

G. Don’t Put the Whole Message In the Subject Line: Contrary to some advice, do 
not start typing your message in the Subject line.  I know some have recommended 
this as a time-saver.  It can be, but it is also more difficult to organize and find email 
drafted in that manner. 

H. Email Is Often Misinterpreted: There are many studies which indicate that 50% 
or higher of emails are misinterpreted regarding tone.  The problem is illustrated by 
the following passage. 

"Don't work too hard," wrote a colleague in an e-mail today. Was she 
sincere or sarcastic? I think I know (sarcastic), but I'm probably wrong.  
According to recent research published in the Journal of Personality and 
Social Psychology, I've only a 50-50 chance of ascertaining the tone of any 
e-mail message. The study also shows that people think they've correctly 
interpreted the tone of e-mails they receive 90 percent of the time.  "That's 
how flame wars get started," says psychologist Nicholas Epley of the 
University of Chicago, who conducted the research with Justin Kruger of 
New York University. "People in our study were convinced they've 
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accurately understood the tone of an e-mail message when in fact their odds 
are no better than chance," says Epley.2 

Therefore, it is imperative that email (and instant messages, for that matter) are 
carefully worded.  When appropriate, you should also consider using emoticons in 
order to clearly convey tone - ;) 

I. Beware of Forwarding Email: Be cautious of forwarding emails.  Read the entire 
email first.  There may be derogatory statements from others deep in the string. 

J. Be Cautious About Blind Copying: You can't trust the recipient to not hit REPLY 
TO ALL!  You are probably better off sending the original and then forwarding a 
copy to desired party. 

K. Avoid Large Attachments: Be cognizant of sending large attachments to people.  
Send links whenever possible using a client portal or a service like Dropbox, Box 
or Citrix ShareFile, when appropriate. 

L. Only Copy People Who NEED To See It: Don't CC people or Reply to All unless 
it is absolutely necessary.  You know how many unnecessary emails you receive a 
day.  Don't be part of the problem – be part of the solution. 

M. Don’t Forward Junk: Don't forward jokes, spam or chain messages. 

N. No Caps: Don't type everything in CAPITALS.  In web-speak, this is equivalent 
to SHOUTING!  If someone does this to you, it probably means he/she thinks you 
are an idiot. 

O. Don't Forward Virus Warnings: 99.9% are hoaxes.  If you are worried about a 
virus rumor and want to check, go to www.snopes.com or www.hoax-slayer.com  
to verify if the warning is legitimate. 

 

IX. DOCUMENT AUTOMATION 

Very few technologies save time like automating the drafting of documents. There are five 
or six primary methods professionals utilize when drafting documents.   They are broadly 
classified as follows: 

A. Cut and Paste/Search and Replace ("Search and Replace"): When creating new 
documents, most professionals simply start with the last document they created for a 
similar client and then modify it (cut-and-paste, search-and-replace) to suit the new client.  
Although this is the most common approach, it has several significant disadvantages.  The 
first is a high margin for error and the second is a lack of speed.  The margin for error (and 

                                                 
2 The Secret Cause of Flame Wars by Stephen Leahy, Wired Magazine, February 13, 2006.  See 
http://tinyurl.com/2eu6un. 

http://www.snopes.com/
http://www.hoax-slayer.com/
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therefore malpractice risk) arises from the fact that Search and Replace is unstructured, 
relies on memory, assumes the word processor will "catch" all of the items in need of 
replacement and requires many steps.  Memories fail, word processors don't catch 
everything and more steps create more mistakes and slower drafting.  Transcribing voice 
recordings or hand written notes and cobbling together provisions from other documents 
makes the process slow.  Finally, particularly with negotiated documents (leases, contracts, 
settlement agreements, etc.), the old document you may be starting with has typically been 
compromised during the prior negotiation process.  So unless you can remember exactly 
what compromises were made, it is actually a terrible document to start with on a new 
transaction.  As a result of the foregoing, Search and Replace is characterized by 
disorganization, mistakes, and inefficiency; and should be avoided whenever possible.   

B. Plain Forms, Model Documents and Templates ("Plain Forms"): Some 
professionals have taken the time to create model documents or templates which contain 
as many language options as possible.  In the alternative, some have broken all of their 
documents down into component parts and assemble their documents by cobbling together 
unique clauses, paragraphs or phrases they've previously organized, categorized and 
labeled.  The language from either approach may contain blanks and/or written instructions 
to the user as to what should be entered into any particular blank and under what 
circumstances optional language should be included or excluded.  This is significantly 
better than Search and Replace, but is still slow and contains a margin for error 
unacceptable to many. 

C. Forms Plus Word Processor Automation ("Forms Plus"): Some professionals 
take the Plain Forms approach, then improve it by adding in automation features available 
in their word processor (typically WordPerfect or Word).  This can mean utilizing merge 
functions, "prompt" fields, macros to expedite the insertion of optional language, and/or 
better use of Word's AutoText or Quick Parts features or WordPerfect's QuickWords 
feature.  It's fairly easy to create templates and utilize the tools that Word or WordPerfect 
provides you for automating those templates.  Automating the fill-in of names and the like 
is fairly easy.  However, unless you're a programmer, gathering lists (beneficiaries, 
trustees, personal representatives, etc.), making language conditional and calculating 
things (such as he/she, him/her, verb conjugation, list punctuation) is extremely difficult, 
particularly in MS Word.  This approach also assumes that you have a mastery of your 
word processor and know, for example, how to utilize automatic paragraph numbering, 
auto-calculating cross references, automatic tables of contents and other higher-end 
features.  If these things aren't built into your templates, then you end up spending a lot of 
time wrestling with formatting issues and paragraph numbering which can significantly 
off-set any efficiencies you may have otherwise gained by utilizing word processor 
automation features.  Having said all of that, you should be utilizing this approach at a 
minimum.  It is superior to Search and Replace and Plain Forms in almost every respect. 
Further, the Search and Replace method is enhanced by the fact that properly created 
templates control list and other formatting making pasting a much more productive step. 

D. Plain Forms + Practice Management Software: Practice Management software 
primarily aids professionals in organizing case information and items related to a case like 
documents, emails, and phone calls. A sometimes overlooked fact is that most case 
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management vendors offer integration options for your Word or WordPerfect templates.  
In practice management or contact management systems, you can store your templates 
within that system.  When a document is created within a specific matter, the equivalent of 
merge codes grabs key information (client names, pleading captions – indeed nearly any 
of the case related database fields).  Though not a true “document assembly” option for 
many this is a strong candidate as the next step. 

E. Commercial Drafting Systems ("Commercial Systems"): Having become 
frustrated with the inefficiency of Cut and Paste, or the amount of time necessary to develop 
and maintain the Plain Forms or Forms Plus approaches, some professionals simply buy or 
subscribe to a Commercial Systems.   

Commercial Systems are widely divergent in terms of sophistication.  For example, I have 
encountered estate planning drafting systems which enable the user to generate incredibly 
complex, customized documents which are valid in all 50 states.  On the other end of the 
spectrum, I have seen systems which are nothing more than the most basic and simple 
forms with fill-in-the-blank technology.  Sophisticated systems can cost as much as 
$5,000+ per year; and simple ones can be as inexpensive as a one-time $200 fee.  Most 
Commercial Systems contemplate that you enter information about your client and in 
return, the system generates customized documents for that client.  Some work in Word or 
WordPerfect; and some utilize their own custom-built word processor environment. 

F. Forms Plus Document Assembly Software ("Document Assembly"): Finally, 
some will take the Plain Forms approach and raise it to another level by utilizing third-
party document assembly software in conjunction with their word processor.  In effect, 
these individuals are creating their own commercial drafting systems.  In fact, many of the 
Commercial Systems available are exactly that:  a combination of Word and/or 
WordPerfect and a home-grown or commercially available document assembly program.  

1. What Is Document Assembly?  Most document assembly programs integrate with 
your word processor and enable you to create sophisticated templates.  Those templates 
typically generate an interview (series of questions) presented to the user.  Upon answering 
the questions, a customized document is instantly generated.  In addition to simply filling 
in blanks, document assembly programs support conditional logic (i.e., include the 
guardianship paragraph if the client has minor children or adult disabled children), infinite 
lists, and the ability to calculate text, numbers and dates.   

The on-screen interview is quite powerful because the template designer can control 
everything about the sequence and content of the interview.  With practice, you can 
reproduce your entire decision tree in the template and build in safe-guards that walk even 
novice users through the assembly process.  An example of how an interview looks is 
shown below: 
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2. How It Works - Big Picture: Using HotDocs as an example, the program allows 
users to replace changeable text with variables (i.e., «Testator Name», «Testator Street 
Address»), make the inclusion of text (words, sentences, paragraphs, etc.) conditional, 
gather (infinite) lists, and automatically calculate dates, text and numbers.   

By “lists”, I mean that the template can gather and process multiple records.  This is 
particularly important with legal documents because there are almost always parties and 
you never know how many there will be.  For example, in a deed, you have grantors and 
grantees.  There could be more than 1 of each.  In estate planning documents, there may be 
multiple children listed, executors/personal representatives, beneficiaries, guardians, or 
trustees.  All of those things are lists.  Good document assembly software lets you enter as 
many parties as necessary and based upon how many you enter, the template will produce 
correct language.  For example, depending upon what the user enters into a list of children 
in a Will, the document may say: 

“Barron Henley has no children.” or 

“Barron Henley has one child, Ariel, age 16.” or 

“Barron Henley has two children, Ariel, age 16 and Alexis, age 14.” or 

“Barron Henley has three children, Ariel, age 16, Alexis, age 14 and Rylee, age 12.” 

The point is that whatever the user enters, the template produces the correct language and 
verb conjugation; and it doesn’t matter how many there are. 

With each new variable, you create a corresponding question (prompt) which is presented 
to the user during the assembly process.  Generating a new document is a simple matter of 
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answering the questions presented by the template.  After the questions are answered, the 
completed document appears on the screen (in Word or WordPerfect), ready edit, save, 
print, etc.     

After a document is assembled, HotDocs allows users to save the answers entered for one 
document so that they can be used to assemble other documents which use the same 
information.  In this manner, users simultaneously decrease the margin for error while 
eliminating time wasted on redundant data entry.  The document produced by HotDocs is 
a plain word processor document and can be edited and stored like any other document. 

3. Document Assembly Options: There are several available document automation 
applications and while each has its own unique way of handling the task, they all are very 
capable and able to achieve the objectives we discuss below.  Each of them work with 
Word or WordPerfect or both.  Some provide the ability to automate PDF forms.  Because 
HotDocs continues to dominate the market and both of us are most familiar with it we refer 
to and show examples from HotDocs throughout this article but we could just as easily be 
referring to any of these applications.  It is highly recommended that you explore the 
various options and decide for yourself which application best meets your needs in terms 
of availability, functionality and cost.  Here are some options to explore: 

• HotDocs - www.hotdocs.com 

• ContractExpress - http://contractexpress.com/ 

• Rapidocs - www.rapidocs.com 

• QShift - www.ixio.com 

• Pathagoras - www.pathagoras.com 

• Perfectus - www. perfectussolutions.com 

• ActiveDocs - www.activedocs.com 

• Exari - www.exari.com 

• AmazingDocs - www.amazingdocs.com 
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